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1.1

This manual is intended as a primer for using Mailware. It
provides detailed instructions for installing and using
Mailware:

How to Install Mailware  - Step by step instructions for
installing Mailware on a single PC or a network.

start section for experienced users.

Using Mailware  - An introduction to the basic features in
Mailware, and how to use them.

The reference manual is provided separately and contains 2
Reference  sections that provide specific information about
the various features in Mailware:

Definitions  - A glossary of terms used in Mailware.

Instructions  - How to complete tasks in Mailware (e.g.,
add a customer, take an order etc.).

In addition to the manual, Mailware contains extensive help
files which you can access at anytime with the F1 key.
Online tutorials are also available by choosing Tutorials
from the Help  text menu item.
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Quick Start Instructions

1. Insert the CD and the Installer will autostart. Or,
double click StartHere.exe on the CD.

2. Click the Quick Install  button.

3. To install Mailware to the recommended default
directory (C:\Mailw15) simply click the Next> button
on each screen.

4. When all steps are complete close the Installer and
run Mailware from its program group.

Note:  For network installations see the About
Network Installations  section (p. 1.7)

Full Installation Instructions

1. Insert the CD and the installer will start automatically
after several seconds. If it does not autostart, right
click the Start  button and choose Explore  to open
Windows Explorer. Left click your CD drive in the left
window pane. Then find StartHere.exe  in the right
pane and double click it.

2. Click the Quick Install  button on the Welcome
screen that appears. During the install you can
specify an install directory, or simply click Next>  at
each prompt to install Mailware to the default location
(C:\Mailw15\).
About the BDE:  For all versions a copy of the

To install a patch, double click it in the Explorer
window that appears.

Borland Database Engine (BDE) will be installed.
Mailware uses the BDE to manage its database. If
when starting Mailware you receive the error:
Exception EBDEngine Error  simply reinstall the
BDE from your CD.

3. Patches and updates may be available on the CD.

To install patches  click the Quick Patch  button.

A small Explorer window (sample below). To install
available patches double-click them.

  
4. Close the Installer by clicking the Exit  button.
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5. To open Mailware, click the Start  button. Move your
cursor to Programs  then to the Mailware  Program
group in the list. Click  Mailware .

When you start Mailware the first time a welcome dialog will
appear and includes a button that opens the tutorials. We
recommend you complete the first set of tutorials that use
the database for the sample company - Lords Flower and
Garden .

Important Note:

When you first run Mailware it defaults to the sample
database. When you are ready to begin entering your
company’s data you can switch to an empty database. For
instructions please see the section:

Switching Between the Sample Database and Your
Database (p. 1.5).

Switching Between the Sample Database and
Your Database

The first time you open Mailware it uses the included sample
company database. The sample company is provided to
help you familiarize yourself with Mailware’s features. A set
of tutorials are included to guide you, and can be opened at
any time by selecting Help  from the text menu, then clicking
the Tutorials  item from the list.

When you are ready to set up your own company, you can
switch to the blank database that installed with the program,
or a network database created by your system administrator
(see the section - About Network Installations on p. 1.7).

To switch databases:

1. Close any open windows (e.g., customers). Choose
File  then Open Company  from the text menu.
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If you are not  using Mailware on a network:

Click the button next to the Local Database  option. This
uses the \Data directory where Mailware is installed. Click
the OK button to complete the switch.

Note: If you have not set up your company yet, choose
Help>Tutorials  from the text menu, and run the
Getting Started tutorial for assistance.

Tip: Even if you are not using a network, you can set up
multiple network databases to run multiple
companies.

If you are  using Mailware on a network:

Select a database from the list and click the OK button. If no
databases are listed you can create one. See the About
Network Installations section (p. 1.7) of this manual. 

About Network Installations

Mailware will work on any network that supports Windows
95, 98, NT or their successors. To install Mailware on a
network, follow the Full Installation instructions (p. 1.2) for
each workstation. You will also need to install a shared data
directory on your server or a workstation you select. The
Network License Installation includes an Install Data
Directory  option for this purpose.

Note: You can install additional copies of Mailware on any
PC’s in your network (even if you purchased only one).
Mailware will allow you to run as many simultaneously as
you have purchased. For example, if you buy 5 licenses and
install Mailware on 10 machines, any 5 can be run at the
same time.

After installing the data directory and a least one copy of
Mailware, you can create a Network Database  which will be
available to all stations under File>Open Company .

To create a network database

Note: Repeat these steps for each copy of Mailware and
each Workstation you install.

2. Start Mailware and choose Tools  from the text menu,
Then select Preferences . On the dialog that opens
click the Network  tab.

Tip: Press the F1 key for more help on setting up a
Network Database.
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The Current Database  portion of the dialog indicates which database is
active. This can be changed with the File>Open Company  text menu
option, and is displayed on this dialog for information purposes only.

3. Check the Override default BDE settings  check box
and change the Control File Directory on each
workstation to point to the same directory, preferably
the data directory they all share. You can specify an
absolute path (e.g., \\SERVER\C\Data) or map a drive
letter for each station (e.g., M:\Data). You can also
simply browse to the data directory by clicking the ...
button that appears in the field.
Note: The Private Directory  defaults to \mailpriv in

the Mailware installed directory, and does not
need to be changed.

4. Click the BDE Administrator button , and answer OK
to the warning message that appears. The following
screen will appear.

5. On the BDE Administrator screen:

a. Click the Configuration  tab.

b. Expand the Configuration  item in the list (click
the +)

c. Expand the System  item.

d. Click INIT then in the right pane change the
Local Share  option to True .

e. (Recommended Step ) You can also change
the Net Directory (Net Dir) default to avoid the
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possible error: Directory is Controlled by Other
.NET File. To do so expand the Drivers  folder,
then expand the Native folder. Click Paradox
in the list. In the right panel change the Net Dir
from C:\ to your Control File Directory (you can
type it, or browse to it). Press the down arrow
key to move to the next line (to ensure the Net
Dir entry is saved).

f. Click the X button in the top right corner to exit
the Administrator, answer Yes to the prompt to
save changes,  and OK to the message about
restarting applications.

6. Click OK on the Mailware Preferences panel to save
the changes. Then proceed to the next step to create
a Network Database.

7. Click File  on the text menu, then select New
Company  from the menu that appears to open the
Network Database dialog (see image below).

8. In the Network Database dialog enter a Name to
describe the database you are creating (e.g., Your
Company Name).

9. In the next field enter the location of the Data
Directory . It may be an absolute address (i.e., the
name of a computer and its drive name - e.g.,
\\SERVER\C\Data) or a mapped drive (e.g., M:\Data).

10. Repeat all steps for each copy of Mailware and each
Workstation on your network

11. Restart Mailware then select File>Open Company
from the text menu to switch to the Network Database
you created. See Switching Between the Sample
Database and Your Database (p. 1.5).

Data Directory Note: It is recommended you use the same
directory you specified as the Control File Directory  in the
previous steps. You can browse to the directory by clicking
the ... button that appears in the field. When you find the
data directory double click it, then click the Save button on
the browse dialog (You do not have to select a file first). If
you receive the error message Directory Controlled by
Other .NET file  see the Help file Error Messages topic for
instructions (Press the F1 key to open Help, then click the
Index button, and select Error Messages  from the list.
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INTRODUCTION TO MAILWARE USING THE TUTORIALS

Mailware is a comprehensive mail order system, designed to The first time you run Mailware a screen prompts you to run
automate nearly every facet of your direct marketing the tutorials. Any time thereafter, simply select Tutorials
operation. You can use it all, or just the parts you need. from the Help  text menu in Mailware.

Because Mailware has so many features, and because The first set of tutorials uses the sample company
some rely on each other, the best approach to fulfilling your database , and guides you through various screens to
goals is to learn the basics: familiarize you with the program. After you have completed

We recommend the online tutorials . They introduce
Mailware’s features and even assist you with setting up your
own data. 

The following section - Using the Tutorials (p. 2.2) explains
how the tutorials work, and helps you get started.

If you are in a hurry you may want to skip the tutorials, and Getting Started  - these tutorials guide you through setup
start setting up your company. and use of Mailware, and can be used to enter your

The section - Getting Started without the Tutorials (p. 2.3)
contains a quick exercise to get you going, and tips for Training  - each one stands alone, or you can run all of them
setting up Mailware. You can take advantage of the tutorials to get in-depth training on Mailware’s modules. These are
too. They may be used in any order once you have some designed to train your employees who perform only specific
basic data set up (customers, products etc.) tasks, like order entry.

Everyone can benefit  from the information in this manual Advanced  - Use these tutorials to make the most of
and the online help files. TIP: Help is always a keystroke Mailware. These tutorials cover advanced features like
away. Just press the F1 key anywhere in Mailware. import/export and creating reports.

them you can switch to your company’s database, and begin
setting up your information. Instructions for switching
databases are in the tutorial, and in this manual in the
section Switching between the Sample Database and Your
Database (p.1.5 ).

Tutorials for use with your database  are divided into 3
categories:

company’s actual data.

For more information see the section Using Mailware (p.
3.1).
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GETTING STARTED WITHOUT THE TUTORIALS

If you prefer to begin using Mailware without running the
online tutorials the following exercise and tips will help you Company Database.
get started.

Note: Mailware defaults to the sample company database
when it is installed. You will want to switch to your
company’s database before using the tips and exercise
below. 

Instructions for switching databases are in the tutorial, and in
this manual in the section - Switching between the Sample
Database and Your Database (p. 1.5 ).

A Quick Exercise
Setting up an Operator ID

1. Open Mailware. Or, if it is already open, press the F5
key to make the Company Database the active
window.

2. If it is not already selected, click the Tables  tab on
the Company Database.

3. Click the System  filter button (the last one above the
tabs with the tools graphic). This filters out any items
that do not belong to the System group, and makes
the list shorter and easier to read.

4. Click the Mailware Professionals  item in the Table

list to select it.

5. Click the Add To  button at the bottom of the

6. In the dialog that opens type an Operator ID of 999.

7. Type your First and Last Name by tabbing to each of
the next fields.

8. Click the Save button. This adds your Name and ID to
Mailware. You can select it when you take an order or
enter a customer contact.

Deleting an Operator ID

1. Now let's delete the ID we added. Select Mailware
Professionals  in the Tables list again, and click the
Open  button.

2. The dialog box will open and display the first Mailware
Professional. If your name is not displayed click the

Navigator buttons  on the toolbar to find it.

3. When your name is displayed, click the Delete icon

 on the toolbar. Answer OK to the message that
pops up.

4. Click the Save button to close the Mailware
Professionals dialog.
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All of Mailware's tables work similarly to this one. You can the Company Database. When you are done you can
edit and add Customers, Products and Ad Source Keys go back to the order, and finish it (if you can’t find the
using the same basic steps. order look in the Windows text menu item).

Quick Start Tips

1 Set up the easy items first: Company Information,
Mailware Professionals, Product Vendors and
Shipping Companies. Company Information is in
Preferences in the Tools text menu. All other items
are all accessible in the Tables tab of the Company
Database.

2. Next input your inventory items. Use the Product form
(again accessible in the Tables tab on the Company
Database).

4. Set up your ads in the Advertising Source Keys form.
If you do not use ad source keys, make some up
now. Future ads should always have source keys (for
example, a classified ad in the Mailware News April
issue might have a key like MM040199).

5. Add a customer, and take an order. You can add the
customer first (using the Customers table), then click
the New Order  button on the Customer form (instead
of clicking the Save button) to take an order for that
customer. The products, ad source keys and other
information you entered in the previous steps will be
available on the order form.

If you forgot to add something, leave the order open,
press the F5 key and open the appropriate table from

6. Experiment with items on the other tabs. Actions will
usually prompt you, and reports are accessible from
the Reports Button on each screen, and the Reports
tab on the Company Database. 

Note: Custom reports can be created with the
Shazam Report Writer. You can learn more about
creating reports in the section - Using the Report
Writer in the Reference manual, the help files (press
the F1 key to open help any time), and the Advanced
Tutorials.

7. Refer to the online help, and the reference manual for
descriptions of many of the items you will run across.
Also, don’t forget the F1 key brings up context
sensitive help.
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THE COMPANY DATABASE

When you start Mailware you will see the text menu and
toolbar at the top of the screen. In the dark grey work area is
a window (shown above) called the Company Database .
This is Mailware’s main menu. Almost everything you do with
Mailware can be launched from here.

Tip : You can access the Company Database at anytime 
by pressing the F5 key.

Inside the Company Database are 3 tabs. These represent

various functions as follows:

Tables  - These access your data either as a list of items, or
individually within a form (e.g., the Customer screen)

Actions  - These are prerecorded functions that work
automatically, or step you through processes.

Reports  - This lists reports which you can print or preview
with the buttons below the list.

Across the tops of these tabs are Filter buttons. These are
used to filter the contents of the tabbed pages. For example,
when the Customers  button is depressed only items related
to your customers are listed. This makes it easy to find the
items you need without scrolling through long lists.

Use the Company Database to access almost everything
you need in the program (a few functions are accessible only
through the text menu, for example, Preferences). For
example, to add a new customer you would:

1. Click the Customer  filer button, then the Tables  tab.

2. Click the Customer  table in the list.

3. Click the Add To...  button at the bottom of the
Company Database.

This is a very intuitive process that should only take a few
moments to get comfortable with. It is also covered in detail
in the Getting Started Tutorials, and in the section of this
manual entitled - How to Add a Record (p. 3.3).
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HOW TO ADD A RECORD (USING TABLES )

Mailware stores your information in a database. Each piece
of data you enter is called a record. Within records are
fields. For example, each customer is a record, and the
individual pieces of information about that customer (name,
address, etc) are fields.

You can add records using the Tables tab in the Company
Database. Mailware uses forms to make entering your
records easy. For example, to enter a customer simply
select Customers  from the Tables list, and click the Add To
button. A form will pop up, and you can begin entering the
customer’s information. All the tables work the same way.
Only the data you enter is different.

Viewing and editing records works the same way, but use
the Open  button on the Company Database (instead of Add
To). Then you can scroll through your records with the

navigator buttons  on the toolbar.

Occasionally a different type of table is used. Instead of a
form showing a single record, a list of all your records will
pop up (for example the Zip Code table). You can edit
records in these lists by simply typing over them, or you can

add a record with the Add button   on the toolbar. 

The other buttons on the toolbar perform similar tasks, and
can be used on both the form and list style of tables. They
are:

Add  - As mentioned above this button adds a record
to your database. Use it when viewing a list of records

(e.g., the Zip Code list). It will also open a new form
when viewing your records individually (e.g., the
Customer form).

Edit  - Use this button to change the contents of the
currently selected record. Note:  On most screens you
can simply enter or change information without first
clicking this icon.

Save - This Save button saves the current record
without closing the form (the Save button found
directly on a form closes the form when it saves the
record).

Cancel  - When adding or editing a record this button
cancels any changes, and leaves the form open (the
Cancel button on a form cancels changes, and closes
the form).

Delete  - This deletes the currently selected record.
You will be asked for confirmation. If you answer OK
the entire record is permanently deleted (e.g., If you
delete a customer, all information about that customer
is deleted).

Note:  To delete just a field within a record simply
select it and press the Delete  key on your keyboard
(e.g., highlight the customer’s name, then press the
Delete  key on your keyboard). Some items require you
hold the Ctrl  key when you press the Delete  key (e.g.,
items in an order).
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HOW TO RUN AN ACTION HOW TO PREVIEW AND PRINT REPORTS

Actions are automated processes that automatically run, or Mailware includes a report writer you can use to print and
step you through a procedure. Each one is different, but self- edit existing reports, or to create your own. Below are
explanatory. instructions for previewing and printing reports. For help with

To run an Action, simply select it from the Company Advanced Tutorials (Help>Tutorials  from Mailware’s text
Database  then click the Open  button. The Action will start. menu), and see the section in the Reference manual - Using

If you need help with any action open it then press the F1
button, and the Help file will open to the appropriate topic.

Some of the Included Actions Are:

PROCESS OPEN ORDERS
Use this action to print invoices, shipping labels etc. and
close open orders.

RECEIVE INVENTORY
Use this action to log the receipt of products shipped to you
by your vendors. The action closes open purchase orders,
and updates your inventory..

ADJUST INVENTORY
Use this action to adjust the in stock quantities of your
inventory. This also works with a bar code wand.

editing and creating reports see the help file,  run the

the Report Writer.

Previewing and Printing Reports

Reports are accessed through the Reports tab  on the
Company Database, and Report Buttons  on various
screens.

To Print a report from the Company Database

1. Click the All  Filter Button, then click the Reports tab .
All available reports will be displayed in the Reports
tab. To make finding reports easier you can view them
by type. To do so click one of the Filter Buttons  on
the Company Database (e.g., to see order related
reports like invoices and shipping labels click the
Order filter button).

2. Select any report you wish from the list, and click the
Preview  button at the bottom of the Company
Database.

3. The Shazam Report Writer will open, and display a
preview of your report. You may be prompted for a
date range. If so, enter the beginning and ending
dates you wish to view in the format mm/dd/yyyy .
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Tip: When prompted for dates click the Cancel button
or press Enter twice to use the report's default date
range. Most reports default to Today's date.

4. To print the report click the Print icon  on the
reports toolbar. A standard Windows print dialog will
open. To print the report click the OK button

To print a report from the Reports Button on any screen.

1. On any screen where it is available click the Reports
Button (e.g., the Reports button on the Order screen
includes invoices, shipping labels etc.).

2. All reports relevant to the current screen will be
displayed in a pop up menu. Select any report from
the list.

3. The Shazam Report Writer will open, and display a
preview of your report. You may be prompted for a
date range. If so, enter the beginning and ending
dates you wish to view in the format mm/dd/yyyy .

Tip: When prompted for dates click the Cancel button
or press Enter twice to use the report's default date
range. Most reports default to Today's date.

4. To print the report click the Print icon  on the
reports toolbar. A standard Windows print dialog will
open. To print the report click the OK button

Printing Selected Pages of a Report

1. Preview the report  as described in the Print and
Preview a Report section.

2. Locate the pages you wish to print  by scrolling

through the preview using the Navigator buttons 

 on the toolbar. Make a note of the page number(s)
you wish to print.

3. Click the print icon  and in the dialog that appears
enter the page range you wish to print. The Print
range is selectable from the dialog in the section that
appears as follows.

You can enter a range of pages (e.g., 1 to 5), or a
single page (e.g., 1 to 1). 

Note:  Reports that do not have a layout defined (as
described in the Help file) can only be printed in full.

REMEMBER:  PRESS THE F1 KEY ANYWHERE IN MAILWARE TO
OPEN CONTEXT SENSITIVE HELP.


